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We met at the
WCSC for our
Christmas meeting
on December 11th
with 37 people in
attendance. Food
included
Candlelight
Chicken George,
sweet potato fries
& onion rings;
salads from
Arthur’s and pies
from Sterling
Farmer’s market.
There was plenty of
chicken sorry that
we ran out of onion
rings, but I believe
everyone got
enough to eat and
many were sent
home with extra
chicken. Santa Joe
had his game
which was too easy,
one group got
everything right,
wait for next year.
Lot of prizes and
fun which was the
main objective.
Joe Fornero

December
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monthly meetings

SCUG BOARD
MEETING MINUTES
DATE 12/15/2021

Meeting was called
to order by: Neal
Attending the
meeting were: Art
Bendick, Cheryl
Johnson, Neal
Shipley, Joe Schmitt,
Janice Maves,, Joe
Fornero, Tom and
Nancy Rich.
Treasurer’s report
was presented by:
Joe F.
Discussion
Highlights:
1): Christmas Party
was a big success.
Many thanks to
Santa Joe for
organizing & running
the event.
2): SCUG will try to
include Zoom for
future in-person
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Future Programs:
Detective Tanner
Wilhelm from the
Sterling PD to give
program on Security
& Scams at our
January meeting.
Adjournment
Respectfully
submitted: secretary
Nancy Rich
Hello All
Neal here. Just
wanted to update
everyone for my Friday night Zoom
meetings.
We will be available
for Dec. 31 and Jan.
7 at 7:30 pm as
usual.
Join Zoom Meeting
https://
us02web.zoom.us/
j/3975898877?
pwd=RjF5ZTM3R25
qNXhHRjdWRVAzQ1
M2Zz09
Meeting ID: 397
589 8877
Passcode: 4ukxAh
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Do You Pay for a Product? If Not, YOU are the Product.
By David Kretchmar

Maybe not always, but hopefully,
we know there is no such thing as
a free lunch by this point in our
lives. Advertising is something we
have come to accept or at least
ignore for most of our lives. We
expect commercials on television,
the radio, newspapers, magazines,
and movies and accept this
advertising knowing that the
revenue generated pays for or
subsidizes the entertainment and
information we want.
The Internet takes advertising to a
new, more personal level. We see
ads directed to us as individuals
rather than generic advertising.
The first time we see ads based on
a recent search, we know
advertising has reached a new
level of personalization. The entity
selling ads is obviously using
information about us to direct
advertising to our eyes.
FACEBOOK
In early April,
yet another
personal data breach was recently
disclosed. Since some time in
2019, the personal data of over
533 million Facebook users was
compromised via their phone
number. In this case, Facebook
users became more of a "product"
than most users had ever
anticipated. Many Facebook users
only recently realized that
Facebook is an advertising entity
that collects a lot of data on each
user.
Free (with advertising) has been a
successful business model for a
long time. However, the recent
Facebook disclosure (along with
other accidental and deliberate
data breaches) causes some to
wonder if this is evidence that
consumers have been treated
poorly by this business model.
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The Next Drawing

AREN'T YOU ALWAYS THE
PRODUCT?
And just because you pay doesn't mean
you're not the product. Cable and
satellite television companies take our
money PLUS sell us (via advertising) to
the various sponsors. Magazines take
our money and still sell ads; banks and
credit cards can charge us money for the
service of having and helping us manage
our money.
Any business that has a "loyalty card"
takes our money for products, services,
and entertainment but gives us a
discount or other benefit in exchange for
the ability to monitor what we are doing.
In other words, we routinely become "the
product" even when we're already
paying.
All businesses treat their customers with
varying levels of respect and provide
different levels of value to us. There is
often no direct correlation between how
much money we pay and the value of the
service we receive.
For example,
someone might
pay a couple of
dollars a week
for online, or a
little more for
delivered paper subscriptions, to The
New York Times or The Wall Street
Journal or the local newspaper, or some
other publication. Yet this same
information is available to people who
read these papers at their local library or
coffee shop at no charge. So, in effect,
we are not paying for the product; we
pay for getting the product in a way we
find much more convenient.
This example is much more complicated
than the black and white "you're the
product" logic allows. For instance, some
users get the service virtually for "free" in
an airplane, using accumulated points or
a "bump" coupon. Other travelers pay big
bucks for the benefit of being
transported to the same destination! So,
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We will resume
the drawings at
our meetings,
there will a
chance at 4-$25
gift cards from
local restaurants
plus some misc.
items.
who or what is the product?
INDIVIDUAL
RESPONSIBILITY
Many entities whose services you pay
for treat their users well, and others
treat users poorly. There are all sorts
of business models online. Some work
in some cases, others work in other
cases. But to argue that "free"
services mean you're "the product"
and thus not treated as well isn't true.
In the online world, each of us must
decide if the value of the product we
receive is worth the inevitable
compromise in our privacy that takes
place.
Suppose we accept the privacy
compromise inherent in most online
experiences. In that case, it is
incumbent on each of us to
understand, compromise, and share
only as much information as
necessary.
By David Kretchmar, Hardware
Technician
Sun City Summerlin Computer Club
https://www.scscc.club dkretch (at)
gmail.com
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Complete Robocall Deterrence Part 2
By John Krout

INTRODUCTION
In Part 1 of this series, you learned how to configure your smartphone so that only your Contacts will
ring your phone, a Whitelist strategy.
That Whitelist solution is not complete because robocaller systems can still find out that your phone
is live simply by recognizing that the call went to your voicemail. And you continue to suffer the
frequent voicemail inbox overload syndrome since many robocallers leave voicemails.
This part 2 article introduces the concept of including the Special Information Tones (SIT). The three
tones beginning phone network messages, such as the number you dialed, are disconnected at the
start of your voicemail greeting. After SIT, you can include your voice telling your Contacts that your
number is indeed live, not disconnected, and they can leave a message.
WHY SIT?
Robocaller systems, like any valuable asset, are focused on the efficient use of system time. So
each robocaller system maintains an internal list of phone numbers known to be valid.
How can robocaller systems determine that a called number is not valid? When the phone number
is disconnected, i.e., the system hears SIT. When robocaller systems hear SIT, the systems remove
the number from their internal list of numbers known to be valid. Then, they don’t call again.
The proof is in the pudding, as some say. In September 2019, I was receiving about 25 robocalls
per week and roughly ten robocall voicemails per week. I implemented this SIT voicemail greeting
strategy in July 2020. Between that time and March 2021, when I wrote this article, I typically
received only two robocalls per week in Missed Calls, and my weekly robocall voicemails dropped to
zero.
zero
Why do I still receive any robocalls? First, because there are hundreds or perhaps thousands of
robocall systems, some systems have yet to call and hear SIT.
CARRIER OPTIONS FOR VOICEMAIL GREETINGS
Typically, phone carrier companies, such as Verizon Wireless, AT&T, and T Mobil, offer three
different ways to create a voicemail greeting.
Automatically state your phone number,
number for instance: You have reached 703-555-1111. Please
leave a message after the beep.
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Play a recording of you pronouncing your name,
name for instance: You have reached the phone of
John Krout. Please leave a message after the beep.
Play a recording of whatever you want to say for your greeting.
So, our strategy will be to use the third option, a recording, to make robocaller systems think your
phone line is disconnected. Most phones expect you to use the phone’s microphone and your own
voice to record that voicemail greeting.
Below, I will show you how to combine SIT and your greeting on your computer. Then, in Part 3 of
this article series, I will show you three ways to transfer that combined audio into your phone for use
as a voicemail greeting.
HOW TO GET SIT
There are websites that curate phone network messages. I downloaded a couple of those messages
and used the free Audacity sound editor to isolate SIT and remove audio noise.
I have posted that cleaned-up SIT online as a monophonic WAV file on the Web. You can download it
from:
https://tinyurl.com/6n5hyb6d
MAKE YOUR GREETING SCRIPT
Before recording, I suggest you type your voicemail greeting
document in a large font, so you can read it easily while
recording.

script in a

Here’s what I used as a script:
Hi, this is John. No, my number is not disconnected. Those
tones were just meant to convince robocallers not to call me
again. You can leave a message after the beep. Thanks.
RECORDING YOUR VOICE
No matter how you record, the phone carriers require that
your custom voicemail greeting has to be monophonic, not
stereo. You can either record monophonic or use Audacity to reduce the
recording from stereo to monophonic.
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Complete Robocall Deterrence Part 2 (cont.)

One convenient way to record your voice is to use a voice recording app on your phone and then
transfer that digital greeting audio file to the
computer. Android
users can download any of several voice
recording apps from
the Google Play Store. Ensure the app
documents the
phone folder in which you can find the digital
audio recording file
for transfer to your computer. For example,
iPhone users can find
the Voice Memos app in the Accessories folder.
Recordings can be
transferred to the computer using iTunes sync.

Alternatively, if you obtained a computer
microphone for virtual online meetings during
the pandemic, or your laptop has a built-in
microphone, you can record your voice directly to
your computer using an application such as the
frees Audacity audio editor.
COMBINE SIT AND YOUR VOICE RECORDING
Audacity provides a convenient multi-track
task.

method for doing this

STEP 1. Open Audacity, pull down the File menu
Then, using the standard Open File dialog box,
recording. After you do that, the oscilloscope-like
recording appears in an Audacity track, like that
1.

and select Open.
Open
load the SIT
depiction of the SIT
shown in Illustration

STEP 2. In Audacity, pull down the File menu and
select Import.
Import Then, using the standard Open file
dialog box, load the voicemail greeting recording.
Audacity places that imported voicemail greeting
recording in a second track, below the track that
contains the SIT recording. You can see an
example in Illustration 2.
2 Audacity adjusts the time scale so that the
longer track is completely visible.
However, both audio recordings start at the same time. Therefore, we
need to move the voicemail greeting recording to the right to start
after SIT ends. Here is how to that happen.
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Complete Robocall Deterrence Part 2 (cont.)

STEP 3. In the second track, click at the time point where SIT ends. A black vertical cursor will
appear in the second track. Again, you can see an example in Illustration 3.
3 In that illustration, the
vertical cursor is circled.
STEP 4. Pull down the Tracks menu. In that menu, select Align Tracks.
Tracks
A sub-menu appears. In that sub-menu select Start to Cursor/Selection Start.
Start This choice means
that the track in which the cursor appears will be moved to the right so that the audio starts at the
cursor.
You can see the menus and choices in Illustration 4.
4
Audacity moves the voicemail greetings in the second track to the right, to the point where you set
the cursor. You can see an example in Illustration 5.
5
At this point, your custom ringtone is ready to be auditioned.
auditioned The play controls in Audacity look like
CD player or MP3 player controls, including a Start at Beginning button, a left-pointing black triangle
with a vertical black bar, and a green triangular Play button.
button Those buttons appear in Illustration 5,
just below the Audacity main menu bar where File and Tracks appear.
Click Start at Beginning and then Play.
Play If you like the result, I strongly suggest you pull down the File
menu and Export the result to a WAV file as a backup.
If you do not already have Audacity installed on your computer, here is the download link:
https://www.audacityteam.org/download/
NEXT UP
In part 3 of this article series, you will learn how to transfer that combined greeting audio to your
phone for recording as a voicemail greeting.
ABOUT THE AUTHOR: John Krout has been writing about creative uses of personal computers since
the early 1980s, and more recently, about creative uses of smartphones. He finished a long career
as a software engineer with 14 years as a technical writer for a federal contractor. He lives in
Arlington, Virginia, with his son, many computers and cameras, and too many cats.
By John Krout, Presenter & Newsletter Contributor
Potomac Area Technology and Computer Society
https://www.patacs.org
jkrout.apcug.presenter (at) gmail.com
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Inserting the Date and Time
By Allen Wyatt

Page 7

Undoubtedly, the time will arise when you need to insert the current date or time in
your document. This may be in the introduction of a letter or in a header or footer.
Word allows you to quickly insert the date or time in several different formats. This
information is inserted as a field which can be updated manually or is updated
automatically when you print the document.
To insert the date or time into your document, follow these steps:
1. Position the insertion point where you want the date or time inserted.
2. Display the Insert tab of the ribbon.
3. Click Date & Time in the Text group. Word displays the Date and Time dialog box.

(See Figure 1.)

1 Figure 1. The Date and Time dialog box.
1. Select a format for the date or time.
2. Select the check box at the bottom of the dialog box if you want the selected date
or time to always reflect whatever is current. If you choose this, it means that Word
inserts the date or time as a field so that it always represents the current date or
time.
Click on OK. The date or time, as specified, is inserted in your document.
Word Tips
By Allen Wyatt
(last updated October 30, 2021)
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The next meeting of the Sauk
Computer User Group will be
January 8, 2021
There will be a Question &
Answer. Bring any questions you
have about your computer or
problems you may be having.
It will be conducted by:
Neal Shipley

Question & Answer : 1 PM
Business Meeting : 2 PM
Presentation: 2:30 PM
Place: Whiteside Senior Center
1207 West 9th Street
Sterling, Illinois 61081

JA N UA RY P R E S E N TAT I O N W I L L B E : S E C U R I T Y
& SCAMS BY DETECTIVE TANNE R WIL HELM
Refreshments will be provided.

